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Using CII with the Application

CII Overview
CII is the data format of the Center for the Informatization of Industry. The CII implementation in the 
application is based on the CII Syntax Rule, which is available in both Japanese and English. The CII 
standard provides a set of syntax rules, specifies details such as looping structures and data types. However, 
it does not include standard message types, which are provided by industry groups. Sterling Commerce 
provides a number of these standard message types, which you can download.

This table describes how the application supports CII:

Functionality Details Action You Need to Take to 
Implement CII

Services CII Envelope service relies on the EDI 
Encoder service to locate the document 
envelope to be used to envelope the 
messages. It takes as input one or more 
messages. Envelopes the messages with a 
message group header and trailer. Values 
are defined in the CII document envelope 
associated with the messages are used to 
build the message group header. Similar to 
the X12 and EDIFACT envelope services.

CII Deenvelope service parses the message 
group. Using values found in the message 
group header, the service attempts to find a 
matching envelope. If a matching envelope 
is found, the envelope defines how the 
message group should be further processed. 
If a matching envelope is not found, the 
service fails and the compliance report 
indicates that the envelope could not be 
found. 

Note: Both CII Envelope and CII 
Deenvelope services are internal 
services that should not be used 
externally for steps in creating 
business processes because it is 
subject to change without notice, and 
use may cause unpredictable results 
and loss of data.

Both CII Envelope service and CII 
Deenvelope service are pre 
configured. It runs as part of a 
predefined EDI business process.
Note: As a way to help reduce the 

number of envelopes you 
need to create and use, the 
CII Envelope and CII 
Deenvelope services 
support use of an asterisk 
(*) as a wildcard character 
in mandatory envelope 
fields for CII. By using 
wildcards, you can set up 
one set of envelopes that 
can be used for multiple 
trading partners. If certain 
trading partners have 
specific requirements, you 
can still have envelopes 
that pertain just to them, 
and the CII Envelope 
service chooses the 
envelope that is the best 
match. In other words, the 
envelope that has the most 
matches to specific fields in 
the data is the one 
selected. 

Envelopes Inbound CII envelope wizard to implement 
inbound CII.

Outbound CII envelope wizard to implement 
outbound CII.

Create the appropriate CII envelopes 
for the CII messages you are sending 
and receiving.
Sterling Commerce, Inc. 5



Using CII with the Application
Prerequisite Knowledge
The audience using this software should be familiar with the application and the CII standard.

Note: This documentation is not intended to explain the CII standard.

Using CII with the Application
To use CII with the application, you must complete the following tasks:

1. Create inbound and outbound CII envelopes.
2. Configure the CIIEnvelope and CII Deenvelope services appropriately. 
3. Use the predefined CII business processes and create your own business processes as necessary. 
4. Create any necessary code lists and maintain them as needed.

Predefined business 
processes

CIIDeenvelope extracts EDI documents from 
a CII interchange and locates an associated 
contract, according to the content of the 
envelopes. CIIDeenvelope then starts the 
appropriate business process.

CIIEnvelope applies a CII envelope to one or 
more CII messages and then uses the 
envelope data to translate and process 
them.

Configure the predefined business 
processes and create new ones as 
necessary.

Map Editor Map Editor wizard enables you to generate a 
file layout for you using the CII message that 
you select. Included in the CII map are the 
map components that are defined by CII.

Properties dialog boxes enable you to define 
and modify map components for CII.

Autolink function automatically creates links 
between input and output fields that have the 
same name or business name. This function 
can be used with any data format.

Additional mapping operations as needed.

Download Map Editor.

Create a map or maps to translate 
your CII messages.

Correlation Search Search by CII information. Use the EDI Correlation search 
functionality to search for CII and EDI 
correlation information.

Reports Report by CII standard. Use the EDI Translation Detail report 
to search for details of inbound and 
outbound CII messages and easily 
create useful reports on your inbound 
and outbound CII messaging.

Functionality Details Action You Need to Take to 
Implement CII
Sterling Commerce, Inc. 6



Using CII with the Application
5. Create your CII map or maps, linking your proprietary file format to the appropriate CII message 
format.

6. To track CII messages, use the EDI Correlation Search functionality.
7. To report on inbound and outbound CII message flow, use the EDI Translation Detail report features.

CII Standard Versions
The following are the versions of the Japanese Center for the Informatization of Industry (CII) standard that 
are included in the application standards database. Descriptions are available in the standards database, in 
Japanese.

✦ CINT0110
✦ CINT0111
✦ CINT0112
✦ EIAJ011A
✦ EIAJ011B
✦ EIAJ011C
✦ EIAJ011D
✦ EIAJ012E
✦ EIAJ012F
✦ EIAJ012G
✦ EIAJ012H
✦ EIAJ012J
✦ EIAJ012K 
✦ EIAJ022D
✦ EIAJ022T
✦ FEPCE12A
✦ FEPCO12A
✦ FEPCS11A
✦ FEPCS12B
✦ FEPCU12A
✦ HIIS0110
✦ HWSW001A
✦ HWSW001B
✦ JGAS0001
✦ JISI0105
✦ JISI0110
✦ JPCA0101
Sterling Commerce, Inc. 7



Using CII with the Application
✦ JPCA0102
✦ JTRNEI00
✦ JTRNEI2E
✦ JTRNFF00
✦ JTRNFF1A
✦ JTRNFF2A
✦ JTRNFF2C
✦ JTRNFF2D
✦ JTRNJI00
✦ JTRNTR00
✦ NEWS0011
✦ TIRAAS03
✦ TIRARA01
✦ TIRARA02
✦ TIRARA03
✦ TIRATA01
✦ TIRATA02
✦ TIRATA03
✦ TRPT011A
Sterling Commerce, Inc. 8



CII Business Processes
CII Business Processes

Overview
To help you accomplish your business goals, the application provides business processes that are used to 
implement CII processing: 

The following table lists business goals for the predefined CII business processes:

CIIDeenvelope Business Process
The CIIDeenvelope business process includes the EDI Deenveloping service to support non-printable 
characters as delimiters and starts the CII Enveloping or CII Deenveloping business processes, as 
appropriate.

If exceptions occur when running an CII Deenvelope business process, the application generates a 
compliance report.

This table lists the configuration parameters for the CIIDeenvelope business process:

Business Process Business Goals

CIIDeenvelope Extracts the content of the envelopes. CIIDeenvelope then starts the 
appropriate business process.

CIIEnvelope Applies a CII envelope to one or more CII messages and then uses the 
envelope data to translate and process them.

Parameter Default Description

Document Tracking False When document tracking is enabled for a business process, 
tracking information is carried with the message throughout the 
process, and the tracking information is persisted about the 
message regardless of the persistence level you configured 
globally for the application. 

Set onfault processing False Onfault processing allows the process to immediately execute 
the application fault activity specified in the process, even if the 
process has not yet reached that step in the process. 
For example, if a process fails at step 3, but the on-fault activity 
is specified in step 7, if onfault processing is enabled, the 
process proceeds to the step 7 on-fault rather than halting at 
step 3.

Set Queue 4 The application enables you to set performance optimizations 
by queue, defining queue levels to allocate resources. This 
number indicates the previously allocated queue level that you 
want for this business process model for processing.
Sterling Commerce, Inc. 9



CII Business Processes
Enable Async Start Mode True Asynchronous initiation is selected by default. Starting 
business processes asynchronously is recommended. 
Asynchronous mode is standard application processing, in 
which the business process is placed in a queue and 
processed.

Enable Transaction False This option instructs the application to treat the entire process 
as a single transaction so that either all of the steps complete, 
or, in the event of an error, none of them complete. When an 
error occurs, no data is committed; data returns to its 
pre-process state. By default, this transaction mode is not 
enabled.

Commit All steps when 
there is error

False This option enables the business process to commit all work to 
the database, at the time an error is generated. With this option 
you can either rollback or commit all work prior to the error 
before the onfault block is called.

Category N/A A category name to which this business process belongs.

Set the Persistence 
Level to

System Default The level of data to retain for generating a status report that 
describes each step that the business process completes. 
System default indicates that, for the data, configuration is 
already defined in the application to retain data.

Set the Event Reporting 
Level to

Full The level of event reporting that is retrieved for this business 
process when it runs. Full specifies to generate events for the 
business process, including the business process start and 
end time, start and end times for all services or services 
running as a result of this business process, and any resulting 
errors and exceptions.

Set the Recovery Level 
to

Manual The level of recovery for this business process if the business 
process should halt during execution. Manual requires you to 
resume or restart the business process manually.

Set the Document 
Storage to 

System Default The level of document storage for messages that process 
when the business process runs. System Default specifies to 
store messages in the file system or database, according to 
how you configured archiving and purging in the application.

Deadline Settings Do not set deadline
Note: To set a 

deadline you 
must change 
it in the 
business 
process.

Complete by – The deadline time, in hours and minutes, by 
which the business process must complete process once it 
starts.

First Notification: Hours and Minutes – Whether to receive 
notification before a business process deadline.

Second Notification: Hours and Minutes – Whether to 
receive another notification before a business process 
deadline. 

Parameter Default Description
Sterling Commerce, Inc. 10



CII Business Processes
The following BPML code makes up the CIIDeenvelope business process:
<process name="CIIDeenvelope">

  <rule name="ack_generated">
    <condition>CII_ACK_GENERATED = "YES"</condition>
  </rule>

  <sequence>
    <sequence>
      <operation>
        <participant name="DeenvelopeCII" />
        <output message="Xout" >
          <assign to="produce_verbose_report">0</assign>
            <assign to="." from="*"></assign>
        </output>
        <input message="Xin" >
          <assign to="." from="*"></assign>
        </input>
      </operation>

      <onFault code="Message-Group-Non-Compliant">
        <assign to="BREAK">YES</assign>
      </onFault> 

    </sequence>
    <sequence>
      <choice>
        <select>
          <case ref="ack_generated" activity="EDI_ENCODE_GENERATED_ACK" />
        </select>

        <sequence name="EDI_ENCODE_GENERATED_ACK">
          <operation>
            <participant name="EDIEncoder"/>
            <output message="Xout">
              <assign to="." from="*"></assign>
            </output>
            <input message="Xin" >
              <assign to="." from="*"></assign>
            </input>
          </operation>    
        </sequence>
      </choice>
    </sequence>

  </sequence>

Life Span System Default The length of time, in days and hours, to retain the data in the 
application, along with the life span type and removal method. 
If you select Process Specific, then you can select the 
number of days and hours for the life span. Also, you can 
select if you want the application to archive or purge a 
business process after its life span is over.

Parameter Default Description
Sterling Commerce, Inc. 11



CII Business Processes
</process>

The following scenario shows how the CIIDeenvelope business process can deenvelope CII documents:

1. The File System adapter collects a file from a CII collection folder and invokes the CIIDeenvelope 
business process.

2. The CII Deenveloping service determines that the file contains a CII document and starts the 
CIIDeenvelope business process.

3. The CIIDeenvelope business process removes the envelopes to make available the transaction set 
envelope for the CII document and determines the next action to perform.

4. For documents with CII Syntax Rule requirements, the CIIDeenvelope business process parses the 
message group and uses the values indicated in the message group header to locate a matching 
envelope. The envelope then determines the next action to perform. If a matching envelope is not 
found, the service fails and the compliance report indicates that the envelope could not be found.

Note: If the CIIDeenvelope business process does not locate a matching envelope, the business process 
stops. The application generates an EDI Compliance Report that describes the reason that the 
CIIDeenvelope business process could not locate the envelope.

Before Using CIIDeenvelope
Before you use the CIIDeenvelope business process, you must complete the following tasks:

1. Create the trading profile, including a contract.
2. Create necessary envelopes.
3. Create a business process that initiates the CIIDeenvelope business processes.

CIIEnvelope Business Process
The CIIEnvelope business process is initiated when it is run as part of a predefined business process. 

The CIIEnvelope business processes performs the following primary activities:

1. Starting with one or more CII documents, the CII Enveloping service relies on the EDI Encoder 
service to be used to envelope the messages.

2. The CIIEnvelope service takes one or more transaction sets and applies an envelope.
3. Using the envelope data, the service either looks up a contract or runs a business process.

This table lists the configuration parameters for the CIIEnvelope business process:

Parameter Default Description

Document Tracking False When document tracking is enabled for a business process, 
tracking information is carried with the message throughout the 
process, and the tracking information is persisted about the 
message regardless of the persistence level you configured 
globally for the application. 
Sterling Commerce, Inc. 12



CII Business Processes
Set onfault processing False Onfault processing allows the process to immediately execute 
the on-fault activity specified in the process, even if the process 
has not yet reached that step in the process. 
For example, if a process fails at step 3, but the on-fault activity 
is specified in step 7, if onfault processing is enabled, the 
process proceeds to the step 7 on-fault rather than halting at 
step 3.

Set Queue 4 The application enables you to set performance optimizations 
by queue, defining queue levels to allocate resources. This 
number indicates the previously allocated queue level that you 
want for this business process model for processing.

Enable Async Start Mode True Asynchronous initiation is selected by default. Starting 
business processes asynchronously is recommended. 
Asynchronous mode is standard application processing, in 
which the business process is placed in a queue and 
processed.

Enable Transaction False This option instructs the application to treat the entire process 
as a single transaction so that either all of the steps complete, 
or, in the event of an error, none of them complete. When an 
error occurs, no data is committed; data returns to its 
pre-process state. By default, this transaction mode is not 
enabled.

Commit All steps when 
there is error

False This option enables the business process to commit all work to 
the database, at the time an error is generated. With this option 
you can either rollback or commit all work prior to the error 
before the onfault block is called.

Category N/A A category name to which this business process belongs.

Set the Persistence 
Level to

System Default The level of data to retain for generating a status report that 
describes each step that the business process completes. 
System default indicates that, for the data, configuration is 
already defined in the application to retain data.

Set the Event Reporting 
Level to

Full The level of event reporting that is retrieved for this business 
process when it runs. Full specifies to generate events for the 
business process, including the business process start and 
end time, start and end times for all services or services 
running as a result of this business process, and any resulting 
errors and exceptions.

Set the Recovery Level 
to

Manual The level of recovery for this business process if the business 
process should halt during execution. Manual requires you to 
resume or restart the business process manually.

Set the Document 
Storage to 

System Default The level of document storage for messages that process 
when the business process runs. System Default specifies to 
store messages in the file system or database, according to 
how you configured archiving and purging in the application.

Parameter Default Description
Sterling Commerce, Inc. 13



CII Business Processes
The following BPML code makes up the CIIEnvelope business process:
<process name="CIIEnvelope">
  <sequence>
    <operation>
      <participant name="EnvelopeCII" />
      <output message="Xout" >
        <assign to="produce_verbose_report">0</assign>
        <assign to="." from="*"></assign>
      </output>
      <input message="Xin" >
        <assign to="." from="*"></assign>
      </input>
    </operation>
  </sequence>
</process>

Before Using the CIIEnvelope Business Process
Before you use the CIIEnvelope business process, complete the following task:

1. Create inbound envelopes for your CII messages.
2. Create outbound envelopes for your CII messages.

Deadline Settings Do not set deadline
Note: To set a 

deadline you 
must change 
it in the 
business 
process.

Complete by – The deadline time, in hours and minutes, by 
which the business process must complete process once it 
starts.

First Notification: Hours and Minutes – Whether to receive 
notification before a business process deadline.

Second Notification: Hours and Minutes – Whether to 
receive another notification before a business process 
deadline. 

Life Span System Default The length of time, in days and hours, to retain the data in the 
application, along with the life span type and removal method. 
If you select Process Specific, then you can select the 
number of days and hours for the life span. Also, you can 
select if you want the application to archive or purge a 
business process after its life span is over.

Parameter Default Description
Sterling Commerce, Inc. 14



CII Enveloping

CII Enveloping Overview
A document envelope consists of control information that enables organizations to effectively exchange 
messages. This information is added in headers and trailers to messages. Document envelopes are specific 
to the message protocol used. Creating document envelopes is necessary to use CII with your trading 
partners.

During the envelope creation process, you need to assign the envelope name, description, and parameters, 
such as unique identification numbers (control numbers).

Note: Each time a user adds, modifies, or deletes an envelope, the action is logged to create an audit trail 
based on the user who performed the event.

Each envelope type has a specific properties page for the envelope and other pages that enable you to specify 
additional requirements for the envelope. Properties for the following envelopes can be found in this 
documentation:

✦ CII Inbound Envelope Properties
✦ CII Outbound Envelope Properties

Envelope Structure
The CII envelope structure has only one level of envelope that is the message group header.

Base Envelopes
The application uses a concept of a base envelope as a starting point to create a new envelope. The base 
envelope maintains a link to the new envelope that inherited its properties. If you modify the base envelope, 
all related envelopes (that is, ones that inherited the base envelope properties) change, as well.

Note: If you plan to create many envelopes using base envelopes, it is recommended that you do not use 
the base envelopes in production. You may want to document how your base envelopes are linked 
to other envelopes.

The default envelope is the version of the document envelope that the application uses. You can specify a 
default envelope only if there are two or more versions of the same envelope. One version must be selected 
as the default.

Types of Envelopes
There are many types of envelopes provided in the application. Each envelope is defined by its envelope 
properties. These predefined enveloping and deenveloping business processes are available for you to 
incorporate into your own business processes. Envelope parameters specify whether the document is 
inbound or outbound: 
Sterling Commerce, Inc. 15



CII Enveloping
✦ Inbound envelopes identify documents that come into the application so they can be properly routed. 
Inbound envelopes also give you the option to translate documents when you choose to check 
documents for compliance. By choosing to translate documents from within the envelope, you can 
reduce document processing time because you do not need to specify a separate Translation service 
step in the business process.

✦ Outbound envelopes identify documents so that they can be sent to and received by trading partners.

Creating a CII Envelope
To create a CII envelope using the application:

1. From the Administration menu, select Trading Partner > Document Envelopes > Envelopes. 
2. Under Create, next to New Envelope, click Go! 
3. On the Envelope Standards page, select CII and click Next: 
4. Select the envelope you want to create, including inbound or outbound, and click Next. 
5. Do one of the following:

To create this envelope from a base envelope, select the Base envelope from the Select Envelope 
list, and click Next. 

Note:All the properties are pre-filled but you can update them as needed.

To create a new envelope, select the Not Applicable from the Select Envelope list, and click Next.

6. On the Name page, type a unique name for the envelope, and a description or comments, then click 
Next. 

7. Complete the properties for the envelope as necessary and click Next after each page until you reach 
the confirm page. Required fields are highlighted in blue. 

8. Click Finish to add the envelope.
9. Click Return to continue.

Updating a CII Envelope
The application enables you to modify any information in your envelopes, except the name of the envelope. 
To update envelope properties:

1. From the Administration menu, select Trading Partner > Document Envelopes > Envelopes. 
2. Find the envelope using the Search or List function.
3. From the list of envelopes, click source manager next to the envelope you want to update.
4. Click edit next to the envelope you want to update.
5. Update envelope properties and settings as necessary, clicking Next to continue.
6. Click Finish to update the envelope.
7. Click Return to continue.
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CII Enveloping
Importing and Exporting Envelopes
The Import/Export feature enables you to save time and increase the accuracy of duplicating resources on 
different systems. This feature enables you to move resources and data between application environments 
of the same version. The Import/Export feature enables you to:

Move from a test application environment to a production application environment.

Move resources from one application system to another.

The ability to import and export envelopes means that you can configure resources on one system and then 
move or copy them to a different system, thereby avoiding having to recreate the resources on each system. 
Even if you have resources that are going to be slightly different from one system to another, you can export 
the resources from one system and import them to a different system, and then make the necessary changes 
to the resource on the second system. 

The Import/Export feature supports several different resource types, including envelopes. 

Note: Importing an export file of envelopes always requires a passphrase, even if a passphrase was not 
required during the export. The passphrase is now required because of the addition of encrypted 
passwords that apply to some envelopes. When you are prompted for a passphrase for envelopes 
during the import of envelopes (when you did not use a passphrase when the envelopes were 
exported), you can supply any value for the passphrase.

Deleting a CII Envelope
Caution: Before deleting a base envelope, consider the impact on all related envelopes (envelopes that 

inherited the base envelope properties).

To delete an individual envelope or all versions of an envelope:

1. From the Administration menu, select Trading Partner > Document Envelopes > Envelopes. 
2. Find the envelope using the Search or List function. 
3. Next to the envelope you want to delete, click source manager. 
4. In Envelope Source Manager page, do one of the following:

To delete an individual envelope: 

Next to the version, under Delete, select the check box. 

Next to Delete Selected Versions, click Go!.

To delete all versions of this envelope, next to Delete All Versions, click Go!.
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CII Inbound Envelope Properties
The following table describes CII inbound envelope properties for the Message Group Header:

Field Description

Sender Code Coded name of the company or division sending the message group. Valid 
value is 12 standard characters. Required. 

Receiver Code Coded name of the company or division receiving the message group. Valid 
value is 12 standard characters. Required. 

Organization Code Coded name of the organization within a company or division receiving the 
message group. Valid value is four standard characters. Required.

Sub Organization Code Coded name of the suborganization within a company or division receiving the 
message group. Valid value is two standard characters. Required.

Edition Edition equates to the version number of the standard message number of the 
standard message. Valid value is two standard characters. Required.

Information ID Code Type of the standard message. Valid value is four standard characters. 
Required.

Operation mode setting Mode of operation as test mode or production (normal) mode. Required. 
Valid values are:

Test

Production (default)

Eight Bit Character Encoding Information interchange referred to in this CII syntax rule; encoding type of the 
1-byte character set. Optional.
Valid values are:

Default Encoding of Platform 

JIS0201 (JIS X 0201, Japanese) - default

SJIS (Shift-JIS, Japanese)

Other 

Sixteen Bit Character Encoding Information interchange referred to in this CII syntax rule; encoding type of the 
2-byte character set. Optional.
Valid values are:

Default Encoding of Platform 

JIS0208 (JIS X 0208, Japanese) - default

JIS0212 (JIS X 0212, Japanese) 

SJIS (Shift-JIS, Japanese) 

Other

Generate a Receiving 
Acknowledgement Message

Generate an acknowledgement that notifies the sender that the receiver has 
received an interpretable transaction message. Valid values are Yes (default) 
and No. Required.
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CII Inbound Envelope Properties
Compliance Check Document Check the transaction set body for compliance. Valid values are Yes (default) 
and No. Required. 

Compliance Check Map Name Which map to use to perform a compliance check. Select the map from the list of 
maps already checked in. Required if Compliance Check Document is set to 
Yes.

Translate transactions Generate transactions according to the standard format from data groups in an 
EDI system and carry out reverse processing. By choosing to translate 
documents from within the envelope, you can reduce document processing time 
because you do not need to specify a separate Translation service step in the 
business process. Required. Valid values are Yes and No (default). 

Handling of Non-Compliant 
Message Groups

Process to follow when non-compliant message groups are encountered. 
Required. Valid values are:

Accept 

Reject (default)

Accept compliant transactions, reject non-compliant transactions

Business Process for 
Non-Compliant Documents

Business process that should run when non-compliant documents are 
encountered. Optional.

Batch messages received within a 
message group into one output 
document. 

Send received batch messages into one output document. If you select No, 
instructs the application to output each message to a separate document. Valid 
values are Yes (default) and No. The default is to output each message to a 
separate document. Required. 

Determine the Business Process 
by

Select a business process that should run with extracted CII messages as the 
primary document. Required. 
Valid values are:

Looking up contract dynamically 

Specifying a contract 

Specifying a business process 

For each document As specified in the Determine the Business Process. Required. Valid values are:

Invoke the business process

Set the business process name in the process data

Business Process List Select a business process to run when this envelope is processed. Optional. 

Contract List Select a previously created contract to associate with this envelope. Optional.

Extraction Options Required. Valid values are:

Determined by a business process

Extract to a file system directory

Extract to a mailbox

Data Extraction Directory Directory for data extraction. Optional.

Data Extraction Filename Filename for data extraction. Optional.

Field Description
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Data Extraction Mailbox Mailbox for data extraction. Required.

Data Extraction Mailbox Message 
Name

Mailbox message name for data extraction. Optional.

Field Description
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CII Outbound Envelope Properties
The following table describes CII outbound (message group header) envelope properties for the Message 
Group Header:

Field Description

Sender Stationed VAN Code Coded name for the value-added network (VAN) of the company or division 
sending the message group. Valid value is 12 standard characters. Optional.

Sending Center Code Computer center sending the message group. Valid value is an alphanumeric 
code with 12 standard characters. Optional.

Sender Code Coded name of the company or division sending the message group. Valid 
value is 12 standard characters. Required. 

Receiver Stationed VAN Code Coded name for the VAN of the company or division receiving the message 
group. Valid value is 12 standard characters. Optional.

Receiving Center Code Agency controlling the computer center receiving the message group. Valid 
value is an alphanumeric code with 12 standard characters. Optional.

Receiver Code Coded name of the company or division receiving the message group. Valid 
value is 12 standard characters. Required.

Organization Code Coded name of the organization within a company or division receiving the 
message group. Valid value is four standard characters. Required.

Sub Organization Code Coded name of the suborganization within a company or division receiving the 
message group. Valid value is two standard characters. Required. 

Edition Edition number of the standard message. Valid value is two standard 
characters. Required. 

Information ID Code Type of the standard message. Valid value is four standard characters. 
Required. 

Syntax ID and Version Number Coded identifier of syntax rules and the version number. Valid value is six 
standard characters. Required. 

Extended mode setting Mode to indicate whether the length of a variable length data element in the 
TFD (transfer form data element) should be compressed or extended if the 
condition determined according to the data type is satisfied. Required.
Valid values are:

Compressed mode (default)

Extended mode 

Operation mode setting Mode to indicate this operation as test mode or production (normal) mode. 
Required. Valid values are:

Test

Production (default)
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Dividing mode setting Mode to indicate message groups are stored in a variable length record file. 
Required. Valid values are:

Dividing mode

Non-dividing mode (default)

Eight Bit Character Encoding Information interchange referred to in this CII syntax rule; encoding type of the 
1-byte character set. Optional. 
Valid values are:

Default Encoding of Platform 

JIS0201 (JIS X 0201, Japanese) - default

SJIS (Shift-JIS, Japanese)

Other 

Sixteen Bit Character Encoding Information interchange referred to in this CII syntax rule; encoding type of the 
2-byte character set. Optional. 
Valid values are:

Default Encoding of Platform 

JIS0208 (JIS X 0208, Japanese) - default

JIS0212 (JIS X 0212, Japanese) 

SJIS (Shift-JIS, Japanese) 

Other

Accepter Lookup Alias Identifying string used with the sender ID and the receiver ID to look up this 
envelope with the EDI Encoder service. This alias associates a document with 
the service it requires. Valid value must be at least one limited standard 
character. Required. 

Map Name Select the map to be used to perform a compliance check. The map must 
already be checked in. Required.

Validate translation input Enables input-side validation to be turned off. Valid values are Yes (default) and 
No. Required. 

Validate translation output Enables output-side validation to be turned off. Valid values are Yes (default) 
and No. Required.

Generate checksums Check and generate sums of specified TFDs (that is, TFD containing a user 
data tag and control data tag), consecutively. Required. Valid values are Yes 
and No (default).

Checksum TFD 1 Transfer form data (TFD) tag of first checksum. Valid value must be at least one 
numeric character. Optional.
Note: Only displayed if you select Yes for Generate Checksums.

Checksum TFD 2 TFD tag of second checksum. Valid value must be at least one numeric 
character. Optional.
Note: Only displayed if you select Yes for Generate Checksums.

Field Description
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Expect an Acknowledgement for 
this Message Group

Whether you expect an acknowledgement that the receiver has received an 
interpretable message group. Valid values are Yes (default) and No. Required.

Acknowledgement overdue after 
(hours)

Amount of time, in hours, within which you must receive an acknowledgement. 
Valid value is four numeric characters. Optional.

Acknowledgement overdue after 
(minutes)

Amount of time, in minutes, within which you must receive an 
acknowledgement. Valid value is four numeric characters. Required. 

Determine the Business Process 
by

Select a business process that should run with extracted CII messages as the 
primary document. Required. 
Valid values are:

Looking up contract dynamically 

Specifying a contract 

Specifying a business process 

Business Process List Select a business process to run when this envelope is processed.

Contract List Select a previously created contract to associate with this envelope. Optional. 

Extraction Options Required. Valid values are:

Determined by a business process

Extract to a file system directory

Extract to a mailbox

Data Extraction Directory Directory for data extraction. Optional.

Data Extraction Filename Filename for data extraction. Optional.

Data Extraction Mailbox Mailbox for data extraction. Required.

Data Extraction Mailbox Message 
Name

Mailbox message name for data extraction. Optional.

Field Description
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Mapping CII Documents

Overview
The Map Editor enables you to map CII documents, and generates a file layout for you using the components 
and message types that you select. The Map Editor-generated CII map consists of groups, composites, and 
fields that are comparable to parameters that are defined by CII.

Note: The CII standards database contains Japanese data. To use it, you must first install the Japanese code 
page into Windows first.

A CII map that contains an FA, FD, or F9 data tag in extended mode on the output side of the map must 
have a Use Constant standard rule defined, so that a detail number is generated. A detail number is 
mandatory for these tags in extended mode.

For CII inbound and outbound processes, you must specify either 8-bit or 16-bit character set in the 
envelope. For 8-bit character set, you can choose JIS0201, SJIS, or Default, where Default is JIS0201. For 
16-bit character set, you can choose JIS0208, JIS0212, SJIS, or Default, where Default is SJIS. If you do 
not set these two values, the default value will be used in translation.

Note: You need to download the Map Editor component to use it.

Map Editor allows you to modify the map components by using the Deactivate, Promote, Split, Copy, Cut, 
and Paste functions.

You can create a map for all CII Standards Release messages loaded into the standards database through the 
Map Editor. 

CII Components in the Map Editor
The following table lists the components that make up the CII layout in the Map Editor, the icons that 
represent the components, and descriptions of the components. For information about adding a map 
component to a layout, see Map Editor Basics. For information about the properties of these map 
components, see Appendix C, Map Editor Properties in the Map Editor guide.
 

Component Icon Description

CII root element The CII File root element represents the CII document that Map Editor is mapping. 
Sterling Commerce, Inc. 24



Mapping CII Documents
About the CII Message
CII headers and trailers are in text, but messages are binary. To read a raw CII message outside of this 
product, you need a hex editor. Using a hex editor, you can see the basic structure of a CII message, which 
consists of: 

✦ Control tags
✦ Transfer form data (TFDs)
✦ Length indicators
✦ Data bytes 
A typical TFD consists of a tag, a length indicator, and data. The length of the element is always indicated, 
so delimiters are unnecessary.

The Translation service handles hexadecimal data in the range of 0x01 through 0xFF. The Translation 
service does not handle 0x00, and thus it cannot translate pure binary data such as bitmaps.

Example
In the following sample is from a dividing-mode CII message, bold indicates the tag and italics indicates 
the length. The data is displayed in hex and spaces are added here for readability.

… 01 04 34 32 39 30 02 04 30 35 30 34 03 06 39 38 30 35 32 39 …

Dividing Mode
Most CII files are sent in dividing mode (also translated as division mode). This mode requires the messages 
to be sent in chunks of 251 bytes to facilitate communications. To set dividing mode, use the Partner Editor.

Note: Dividing mode does not affect message group headers or trailers because they are always 251 bytes.

Group A group is a looping structure that contains a sequence or an implicit group of repeating 
field tags (in Map Editor, a group is related segments and groups that repeat in sequence 
until either the group data ends, or the maximum number of times that the loop is 
permitted to repeat is exhausted). 
A group that is subordinate to another group is a subgroup (and corresponds to a nested 
looping structure, a loop within a loop). 
When a group contains an extended rule or a standard rule, an asterisk appears to the 
right of the group icon.

TFD Transfer form data (TFD) is a block of data that consists of a tag, a length indicator, and 
data. The length of the element is always indicated, so delimiters are unnecessary.
When a TFD has a link performed against it, a red check mark appears over the TFD 
icon.
When a TFD contains an extended rule or a standard rule, an asterisk appears to the 
right of the TFD icon. 

Component Icon Description
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Mapping CII Documents
Non-transparent Mode
According to the CII Syntax Rule, non-transparent mode is an option that helps you avoid interfering with 
communication control characters in some communications systems.

Using Extended-mode Tags
According to the CII specification, tags are in either compressed or extended mode. The following table 
illustrates the differences.

A TFD is in compressed mode unless an extended-mode indicator (0xF0) was previously encountered in the 
TFD stream.

About CII Control Tags
The following hexadecimal control tags are used in CII: 

Creating a CII Map
When you create a new map, you can either manually create an EDI layout or you can use a wizard that 
creates a layout for you based on an EDI standard. The wizard saves you time and effort and minimizes the 
risk of having an invalid standard format.

Note: If the map you are creating contains greater than 20,000 objects, you will receive a message noting 
that this map contains a very large number of objects. For best performance, it is recommended that 

Mode Size Range (Decimal)

Compressed 1 byte 1 - 239

Extended 2 bytes 1 - 61439

Control Tag Function

0xF0 Starts extended mode

0xF2 Length extender

0xF7 Length indicator

0xF8 Escape indicator

0xF9 Internal segment separator

0xFA/0xFD Multi-detail header (loop start)

0xFB Multi-detail return

0xFC Multi-detail trailer (loop end)

0xFE Message Trailer
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Mapping CII Documents
you consider whether any unnecessary objects in the map can be removed, do not expand the entire 
object tree—expand only the section of the tree you are currently mapping, consider using the Show 
links to or from the currently selected element option instead of the Show links to or from all 
visible elements option, and save the map using the .MAP file format (using the Save As function).

To create a CII map:

1. From the Map Editor File menu, select New.
2. In the New Map Wizard, complete the questions in the first window and click Next.
Note: Be sure that Sterling Integrator is selected in the What kind of map are you creating list.
3. If you are translating from CII, in the Input Format window select the Create a New Data Format 

Using this Syntax option. 
4. Then, select CII. If you are translating from another format, select that format and continue to the next 

page of the wizard.
5. Select the ODBC data source that contains the standards database (the default is Sterling Integrator 

Standards) and click Next.
Note: If you want to use Japanese descriptions, select the Use Japanese descriptions, if available check 

box and click Next. Otherwise, just click Next.
6. Click Finish to load the transaction set.
7. Click Next to select the Output Format.
8. If you are translating to CII, in the Output Format window (select the Create a New Data Format 

Using this Syntax option. 
9. Then, select CII and click Customize. If you are translating from another format, select that format 

and continue to the next page of the wizard.
10. Select the ODBC data source that contains the standards database (the default is Sterling Integrator 

Standards) and click Next.
Note: If you want to use Japanese descriptions, select the Use Japanese descriptions, if available check 

box and click Next. Otherwise, just click Next.
11. Click Finish to load the transaction set. The Map Editor displays the new map in the Map Editor 

window.
12. In the Map Editor, select File > Save to save the map. Do not use spaces or apostrophes in the map 

name. 
Note: To compile the map, select File > Compile. A progress dialog box displays and updates during the 

compilation process. If the map contains a large number of objects, you may be prompted that you 
should save the map in .MAP format.

13. To save a map as a .map file, select File > Save As and then select Source Maps (*.map) from the Save 
as type list.

Note: Prior to opening an .mxl (XML-formatted) file, the Map Editor verifies that you have the Microsoft 
XML Core Services (MSXML) 4.0 installed on the same computer as Map Editor. If you do not have 
the Microsoft XML Core Services (MSXML) 4.0 installed, the Map Editor cannot save or load .mxl 
source files.
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CII File Properties Dialog Box
This table contains the parts and functions for the CII FIle Properties dialog box:

Part Functions

Name Tab

Name Map Component name.
Note: Do not use spaces or hyphens (-) in the name. You can use the underscore (_) 

to separate words.

Description Description of the map component.

Additional notes When you import an XML schema, the annotation attached to each XML map component 
is saved in this box. For non- XML map components, contains any user-defined 
comments.

Mode Tab

Dividing Mode Most CII files are sent in dividing mode (also translated as division mode). This mode 
requires the messages to be sent in chunks of 251 bytes to facilitate communications. To 
set dividing mode, use the Partner Editor. Default. 

Non-Transparent Mode According to the CII Syntax Rule, non-transparent mode is an option that helps you avoid 
interfering with communication control characters in some communications systems. 
Transparent mode is the default setting in the application.

Character Sets tab

Select 8 Bit Character 
Set

Valid values are Default, JIS-X0201, and Other. Default instructs the translator to use the 
default character setting of the computer on which the translator is running. Use Other if 
you must specify any other type of character encoding.

Select 16 Bit Character 
Set

Valid values are Default, JIS-X0208, and Other. Default instructs the translator to use the 
default character setting of the computer on which the translator is running. Use Other if 
you must specify any other type of character encoding.

Loop Extended Rules tab

On Begin Extended rule to be run before the translator processes the map object.

On End Extended rule to be run after the translator concludes processing the map object. Map 
Editor processes On End rules at the end of each loop occurrence, not at the end of all 
loops.

Full Screen Maximizes the dialog box.

Compile Compiles the extended rule. This function enables you to view compile errors for this rule 
prior to compiling the translation object. This function gives you immediate feedback 
about the accuracy of your rule. Double-click an error to immediately navigate to the line 
containing the error.
The rule is also compiled when you compile the map.

Extended rule Defines the extended rule.
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CII Group Properties Dialog Box
This table contains the parts and functions for the CII Group Properties dialog box:

Errors Displays any errors generated when you clicked the Compile button to compile the 
extended rule. Double-click an error to make the cursor go to the line containing the 
error.

Part Functions

Name Tab

Name Map Component name.
Note: Do not use spaces or hyphens (-) in the name. You can use the underscore (_) 

to separate words.

Description Description of the map component.

Additional notes When you import an XML schema, the annotation attached to each XML map component 
is saved in this box. For non- XML map components, contains any user-defined 
comments.

Looping Tab

Minimum usage Minimum number of times the loop must be repeated.
For a conditional loop, the minimum usage is zero.

Maximum usage Maximum number of times the loop must be repeated.

Promote records to 
parent

Select this check box to specify that when the group is compiled, the subordinate records 
and groups are extracted from the loop and located in the parent group. This function is 
valid for single iteration subgroups only.
Note: Select this check box if you are mapping the fields in this group to data that is 

not grouped in the output.

Get usage from related 
field

This is supported on the input side of the map only. If this option is selected, you can 

associate the usage of a group or segment with the value stored in another field.

Note: This options is disabled for SWIFT.
The field associated with the usage must meet the following requirements:
✦ It must be in a segment that’s contained in the same group as the segment 

whose usage is being determined.
✦ It must be in a non-repeating segment.
✦ It must be in a segment that precedes the segment whose usage is being 

determined.
✦ It must be an integer field.

Ordering tab

Part Functions
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CII TFD Properties Dialog Box
This table contains the parts and functions for the CII TFD Properties dialog box:

Normal

Start random order

Inside random order

End random order

Used for the input side of the map only. The order in which the group, segment, or record 
can occur.
Note: If you are using a non-EDI syntax like CII and wish to use this feature, you must 

manually set the ordering start/inside/end group and segment points and also 
set the associated Ordering Tag.

Ordering Tag Used to perform validation on the ordering types to ensure there is a start and end for 
every defined ordering sequence. The following caveats apply to this parameter:

The Ordering Tag must be the same for a related sequence of groups or segments.

The Ordering Tag is not valid for the XML syntax.

This parameter is only enabled (and is mandatory) when you select Start random 
order, Inside random order, or End random order.

Loop Extended Rules tab

On Begin Extended rule to be run before the translator processes the map object.

On End Extended rule to be run after the translator concludes processing the map object. Map 
Editor processes On End rules at the end of each loop occurrence, not at the end of all 
loops.

Full Screen Maximizes the dialog box.

Compile Compiles the extended rule. This function enables you to view compile errors for this rule 
prior to compiling the translation object. This function gives you immediate feedback 
about the accuracy of your rule. Double-click an error to immediately navigate to the line 
containing the error.
The rule is also compiled when you compile the map.

Extended rule Defines the extended rule.

Errors Displays any errors generated when you clicked the Compile button to compile the 
extended rule. Double-click an error to make the cursor go to the line containing the 
error.

Part Functions

Name Tab

Name Map Component name.
Note: Do not use spaces or hyphens (-) in the name. You can use the underscore (_) 

to separate words.

Description Description of the map component.

Part Functions
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Additional notes When you import an XML schema, the annotation attached to each XML map component 
is saved in this box. For non- XML map components, contains any user-defined 
comments.

Tag Tab

Tag The element ID, which is defined by a CII standard.

Hex Whether you view the tag in hexadecimal or decimal and applies only to what you see in 
the Map Editor. 

Decimal This setting does not affect translation.

Looping tab

Normal

Loop Start

Loop End

Loop Repeat

Type of loop. Values are:

Normal – In the loop, but is not the beginning or ending

Loop Start – Marks the beginning of the loop

Loop End – Marks the end of the loop

Loop Repeat – Marks the end of one loop iteration and the beginning of the next 
iteration

Validation tab

Mandatory field Select this check box to indicate that the map component is required.

Minimum length Minimum number of characters in the map component.

Maximum length Maximum number of characters of the map component.

Data-type Type of data for this map component. Valid values are:

String - Alphanumeric

Number - Numeric, real, overpunched, or packed (for Positional only)

Date/time - Date or time

Data format How the data in the map component will be formatted.
Depending on the data type you selected, you can either:

For the String data-type, select a syntax token to denote that this map 
component must be formatted as the syntax token dictates.

Free Format indicates that any characters are acceptable in the field. The 
translator does not check the characters for compliance.

For Number or Date/Time data-type, select the data format from a list.

Data is Read/written as 
Raw Bytes

Type of byte ordering:

Little-endian byte ordering specifies that the least significant character is first. 
Intel and Windows use this order.

Big-endian byte ordering specifies that the most significant character is first. 
UNIX and Java use this order.

Part Functions
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Configuring a Loop
In CII terminology, a loop is expressed as a multi-detail. Multi-details are indicated through the use of 
specific TFDs. A multi-detail header (MDH) is used before the start of a loop, and at the end of each iteration 

Positive Number Format 
Default

Specifies the value used at field-level configuration dialog boxes. The default is Don’t 
allow/generate ‘+’ prefix. Valid choices are:

Use properties file setting (specifies that the rule or rules specified in the 
customer_overrides.properties file is followed)

Don’t allow/generate ‘+’ prefix (specifies that regardless of whether the 
customer_overrides.properties file contains a rule or rules to allow the “+” prefix, the 
plus sign will not be used for the field)

Allow/generate ‘+’ prefix (specifies that even if the customer_overrides.properties file 
indicates that the “+” prefix is not allowed in maps, the rule or rules will be overridden 
and the plus sign will be used for the field)

Standard Rule Tab

Please select the 
standard rule to use

The standard rules from which you can select are:

Select

Update

Use System Variable

Use Constant

Use Accumulator

Loop Count

Use Code

For more information on using standard rules, see the Map Editor User’s Guide.

Extended Rule Tab

Extended Rule Area where you type the extended rule.
For more information on using extended rules, see the Map Editor User’s Guide.

Full Screen Enlarges the extended rule area to the size of your entire display to give you more room 
to see what you type.

Compile Compiles the extended rule. This function enables you to view compile errors for this rule 
prior to compiling the translation object. This function gives you immediate feedback 
about the accuracy of your rule. Double-click an error to immediately navigate to the line 
containing the error.
The rule is also compiled when you compile the map.

Errors If you compiled this extended rule, any warnings or errors are displayed in the Errors list. 
Double-click an error to make the cursor go to the line containing the error.

Character Set tab

Character Set Select 8 Bit (Default) if the TFD is single-byte, and 16 Bit if the TFD is double-byte.

Part Functions
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there is a multi-detail return (MDR). The multi-detail trailer (MDT) is located at the end of the loop. The 
following table shows how a multi-detail is typically configured: 

Configuring Key Fields for Multi-Detail Headers
In extended mode, you must identify multi-detail headers with key fields. You must also specify key fields 
if there is any possibility of ambiguity in the data (for example, if a multi-detail in the CII file layout has no 
corresponding data).

Note: Key fields are intended to be used with string fields only. If you use a key field on a numeric field, 
the result is not guaranteed.

To configure a key field for a multi-detail header:

1. In the Map Editor, double-click or right-click the multi-detail header and select Properties.
2. Click the Key Field tab. 
3. Select Use constant and click Edit.
4. In the Map Constants dialog box, type the constant you need.

About Character Encoding
An encoding system determines the hexadecimal values that represent display characters. The Map Editor 
uses the default character set of the computer you are working on. The default encoding for Japanese 
Windows is Shift-JIS although there are several other encoding systems for Japanese characters.

When you are specifying character sets for the CII side of a map, you must indicate one character set each 
for 8-bit and 16-bit characters in the CII File Properties dialog box. Then in the CII TFD Properties dialog 
box, you indicate whether the TFD uses an 8-bit or 16-bit character set.

TFD Type Tag Properties

Multi-detail header (MDH) 0xFA One-byte string

MDH 0xFD Two-byte binary numeric type N0

Multi-detail return (MDR) 0xFB No data

Multi-detail trailer (MDT) 0xFC No data

Tag Data Type Range of Values

0xFA String A to Z, 1 to 9

0xFD String 0000 to 65535
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Mapping CII Documents
Relating CII Data Attributes to Map Editor Data Types 
The following table shows how CII data attributes correspond to the data types in the Map Editor:

About Syntax Tokens
To process Japanese characters, you must use a syntax token that enables non-Latin characters in the data 
that the map will process. The Map Editor provides the syntax token K, which enables all double-byte 
Japanese characters. 

You can create a syntax token to meet your specific needs. If you create a double-byte character set (DBCS) 
syntax token, you must configure the syntax tokens on a computer with a DBCS operating system (Japanese, 
Korean, Traditional Chinese, or Simplified Chinese) or a Windows 2000 system to which you have added 
font support for one of those languages. If you do not configure syntax tokens, the DBCS button is inactive 
and you are unable to use it. Syntax tokens cannot be imported. 

Preserving Leading Spaces When Mapping to a Positional Data Format
In the EDIFACT and ANSI standards, leading spaces in fields are eliminated. However, in the CII format, 
according to the CII Syntax Rule, leading spaces are typically preserved (although they can be eliminated).

To preserve leading spaces in a map for translating CII to the positional format:

1. From the Map Editor Edit menu, select Details.
2. In the Map Details dialog box, select Use Configurable Trimming and click OK to close the dialog 

box.
3. In each field on the positional side of the map, open the Field Properties dialog box, and click the 

Position tab.
4. If the spaces are single-byte:

a. In the characters used in empty portions of the map box, type SP.
b. From the data alignment options, select beginning of the field.

5. If the spaces in the field are double-byte and the data is encoded in Shift-JIS (windows code page 932), 
for Enter the character used in empty portions of the field, type 0x8140 or the appropriate key code 
combination.

Description of Data CII Attribute Map Editor Data Type

Numeric, implied decimal 9 N0 to N9

Numeric, explicit decimal N R0 to R9

8-bit characters X X, J, or other single-byte syntax 
token

16-bit characters K K, double-byte syntax token

8-digit date Y Date: YYYYMMDD
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6. Click OK.
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CII Reporting
The EDI Translation Detail report enables you to access EDI data (for a particular standard like CII) for a 
specified time period. It further allows you to organize the report by selecting criteria such as direction of 
the transmission, sender and receiver identifier, envelope name, unique identifier for the envelope level, 
EDI standard used, and translation success or failure, among other parameters. This report allows you to 
quickly and easily access information about EDI translation through the system. 

To run a report containing details on inbound/outbound CII messages:

1. From the Operations menu, select Reports.
2. Use the Report Configuration wizard to create a new EDI Translation Detail report. Click Go! to 

create a new report configuration.
3. In the Type page, select EDI Translation Detail from the from the drop down list and click Next.
4. In the Report Configuration Name page, give a unique Name for the report and a meaningful 

description in the Comments box and click Next.
5. Select the transaction level and click Next. The valid options are:

Transaction

Group

Interchange

6. In the Report By page, select the Reports by Fields from the drop down list. The options are available 
based on the option selected for the transaction level:
If you select the Transaction option for the transaction level, then you get the following options:

Sender ID-Receiver ID

Transaction Envelope

If you select the Group option for the transaction level, then you get the following options:

Group Sender ID-Group Receiver ID

Group Envelope

If you select the Interchange option for the transaction level, then you get the following options:

Interchange Sender ID-Interchange Receiver ID

Interchange Envelope

7. On the Detail Filtering page in the Standard parameter, clear the checkboxes for all standards except 
CII.

8. Filter by any other desired criteria like Date or Time.
9. Select the Display Order whether Ascending or Descending.
10. In the Confirm page, verify the settings that you have selected and click Finish at the end of the Report 

Configuration Settings Wizard to generate the report.
Note: You can view the report in any of the following formats:
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PDF

HTML

XLS
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Searching for CII Correlations
Correlation data, often called correlations, is defined as specific pieces of data that you may need to review 
in the process of monitoring, tracking, and troubleshooting your activities. These data items are defined by 
type and value. These type-value pairs are known as name-value pairs, and are a powerful tool you can use 
to record and search for business process- and document-specific data. The application has some predefined 
correlations and enables you to define more so that you can easily and efficiently monitor and track your 
activities, such as CII message flow.

To search for CII correlations:

1. From the Administration menu, select Business Process > Advanced Search > EDI Correlation.
2. In the Search Option area, specify any combination of the following search criteria, as appropriate. To 

search for CII messages, in the Interchange Level Options > Standard box, type CII.
3. Click Go! to display the EDI correlation records that match your search criteria.

4. In the EDI Correlation Interchange Results page, click info in the Detail column for the CII 
interchange for which you want to view details.

5. In the EDI Correlation Interchange/Group/Transaction Detail Results page, click info to the right 
of Document Correlations for additional information about the CII messages.

6. Click info to the right of Business Process for additional information about the CII business 
process.
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